# Table of Contents

1. FAXVIEW GUIDE ................................................................................................................................. 1
   1.1 FaxView Login and Exit .................................................................................................................. 1
       1.1.1 FaxView Client Login ......................................................................................................... 1
       1.1.2 WebFax Client .................................................................................................................... 2
       1.1.3 FaxView Exit .......................................................................................................................... 3
   2. Fax Operation ..................................................................................................................................... 4
      2.1 Menu Bar .................................................................................................................................... 4
      2.2 Fax List ..................................................................................................................................... 7
      2.3 Left Panel .................................................................................................................................. 7
      2.4 Status Bar ................................................................................................................................. 8
      2.5 Help .......................................................................................................................................... 8
   3. Fax Transmission ............................................................................................................................... 8
      3.1 Quick Transmission .................................................................................................................... 8
      3.2 Complete Transmission and Send Email by FaxView ............................................................... 9
      3.3 Mass Fax .................................................................................................................................. 12
      3.4 Adds-in ...................................................................................................................................... 15
   4. Fax Reception .................................................................................................................................... 20
   5. Fax View .......................................................................................................................................... 20
      5.1 View ......................................................................................................................................... 21
      5.2 Print .......................................................................................................................................... 21
      5.3 Sorting ....................................................................................................................................... 22
      5.4 Print .......................................................................................................................................... 22
      5.5 Refresh ...................................................................................................................................... 23
      5.6 Search ...................................................................................................................................... 24
      5.7 Move ......................................................................................................................................... 30
      5.8 Delete ...................................................................................................................................... 31
      5.9 Edit .......................................................................................................................................... 32
      5.10 Combine .................................................................................................................................. 32
      5.11 Split ......................................................................................................................................... 33
      5.12 Reply ....................................................................................................................................... 33
      5.13 Forward (to Internal Users) ..................................................................................................... 34
      5.14 Route ....................................................................................................................................... 34
      5.15 Out (to External Fax Numbers) ............................................................................................... 35
      5.16 Resend ..................................................................................................................................... 35
      5.17 History ..................................................................................................................................... 35
      5.18 Right Mouse Click .................................................................................................................... 36
      5.19 Heavy Fax Data Loading ......................................................................................................... 36
   6. TIFF Viewer ....................................................................................................................................... 36
      6.1 Save .......................................................................................................................................... 37
      6.2 Normal view and Page break view ............................................................................................. 37
      6.3 Print .......................................................................................................................................... 38
      6.4 Print page break .......................................................................................................................... 38
2.6.5  Paint on Fax .................................................................................................................................39
2.6.6  Attachment Fax image to Email directly.........................................................................................40
2.6.7  Add text and text stamp ..................................................................................................................40
2.6.8  Freehand draw tool .........................................................................................................................42
2.6.9  Time stamp tool ...............................................................................................................................43

2.7  Folder Management ..............................................................................................................................43
2.7.1  Create Folder .....................................................................................................................................43
2.7.2  Edit Folder ..........................................................................................................................................44
2.7.3  Delete Folder .....................................................................................................................................45

2.9  Phonebook ...........................................................................................................................................46
2.9.1  View Phonebook ..............................................................................................................................46
2.9.2  Phonebook Search ............................................................................................................................46
2.9.3  New Phonebook ................................................................................................................................47
2.9.5  Edit Phonebook ................................................................................................................................48
2.9.6  Delete Phonebook Record ................................................................................................................49
2.9.7  Import Phonebook ...........................................................................................................................49
2.9.8  Export Phonebook ............................................................................................................................50
2.9.9  Share Phonebook ............................................................................................................................50
2.9.10 Refresh Phonebook ..........................................................................................................................51

2.10  User Profile .........................................................................................................................................51
2.10.1  Send Profile ....................................................................................................................................51
2.10.2  User Information .............................................................................................................................52
2.10.3  Change Login Password ................................................................................................................52

3.  PRINT TO FAX .......................................................................................................................................55
1. FAXVIEW GUIDE

1.1 FaxView Login and Exit

1.1.1 FaxView Client Login

Follow the below steps to log in FaxView Client:

Open the OceanFax FaxView. To open the program, click Start > All Programs > OceanFax FaxView or double click the shortcut icon at the desktop.

Log in. If it is your first time to log in, you need to input server information (Format: Server IP Address: Port, the default port is 80 or leave it blank), User ID and Password. Click Log in to access the FaxView interface.

“Server “option: The login interface will store the server information, including the Server IP and Port Number, which you input when you logged in before. Select the server in the drop-down list of servers.

“Remember password “option: If a user ticks this option, once he enters his password, the system will remember. When he logs in next time, the password will be automatically entered. Otherwise, he needs to retype the password every time you log in.
1.1.2 WebFax Client

- OceanFax provide a simplify web client for user to manage their fax, user can follow below to access WebFax client.

1. In internet browser (support IE and Chrome)
2. Type http://144.214.5.190/WebFax in address field.
3. Below screen will show.
4. Input user name and password as same as the step to login to FaxView client.
5. Other operation, user can reference to the FaxView instruction in this guide.
Notes:

WebFax client is only a simplify version of FaxView, not all the FaxView function included in WebFax client. Such as Report, Auto Forward setting, Auto Print setting, etc.

1.1.3 FaxView Exit

1. Exit FaxView Client: Click **Exit** on menu bar or click top right x.

2. Exit FaxView Web Client: Click **Exit** on menu bar or close IE.
2.2 FaxView Overview

FaxView is the main interface where users send, receive and manage their faxes.

It is divided into four sections including menu bar, fax list, left panel and status bar.

2.2.1 Menu Bar

Users can perform various operations on all the inbound and outbound faxes by clicking the buttons in menu bar.

2.2.1.1 Fax Tab

OceanFax FaxView supports ribbon interface by listing main operation buttons on Fax Tab in menu bar.

- **New Fax**: Launch a new fax form
- **Reply**: Directly reply to an inbound fax, with no need to input recipients to avoid any mistake due to manual input
- **Forward**: Forward a fax to other users and keep one copy
- **Route**: Pass a fax to other users with no copy left
- **Out**: Forward a fax to external fax numbers
- **Move**: Move faxes to different folders according to fax type, importance, the related projects or
by habit for storage

- **Resend**: Turn an outbound fax as a new fax’s attachment and send it again and allow to resend multiple faxes at one time

- **Delete**: Clean up outdated or junk faxes periodically to keep FaxView a clean interface and the deleted faxes will disappear from the fax list in FaxView and yet still be stored in Trash folder.

- **Edit**: Modify some information of an inbound fax to update some of its properties.

- **View**: View faxes by implementing OceanFax’s original fax viewer - Tif Viewer

- **Split**: Split a multiple-page fax into multiple individual faxes according to requirements. The fax created by split will be regard as a new fax.

- **Combine**: Combine two or above selected whole faxes or part of faxes to a new fax for transmission or easy management and review. The fax created by combining the existing faxes is regarded as a new fax. Its subject will be “Combine from faxes: xxx, xxx” (xxx as the document ID of the faxes”). All the faxes to be combined must be inbound or outbound faxes at the same time.

- **Release**: This option is designed for the faxes needs preview before sending. A user can preview a fax that is held for preview by using this option and click this button again to release the fax for delivery after preview.

- **Suspend**: When a user needs to put the transmission of some faxes in higher priority, he can suspend outgoing faxes using this option. If a fax is suspended, no user is allowed to perform any operations on it. Only when a fax is in the status of “Waiting for Creating Cover Sheet”, “Held for Preview”, “Waiting for Approval” or “Waiting for Sending”, can a user preforms this operation.

- **Resume**: When a fax is suspended, a user can cancel the suspension by using this option and goes on perform other operations on the fax.

- **Priority Setting**: When a user needs to put the transmission of a fax in higher priority, he can suspend it first and then set its priority by using this option.

- **Approve**: When a user creates a new fax, if he ticks at **Need approval** and selects an approver, the fax status will be “Waiting for approval”. Only after the approver approves the fax, can the fax be transmitted.

- **Print**: To print highlight fax to printer, support multiple faxes selection.

- **Refresh**: FaxView automatically refreshes for every 5 minutes. Users are also allowed to click **Refresh** in Fax Tab to refresh the fax list manually and set up automatically refresh interval by click the down arrow under **Refresh** button.

- **History**: Users are allowed to view the record of the execution of each step on each fax, including transmission, view, conversion, approval, and etc.

- **Search**: OceanFax supports quick Search, advanced Search and fax data filter

- **Preview**: Preview the content without opening the fax images. Only when the status of a fax is “successfully converted” or after, can a user previews it (except the status of “Waiting for generating a cover sheet” or “Waiting for conversion”)

Page | 5
• **Sorting**: Faxes can be sorted in the fax list based on the sender’s identification or other fields. FaxView will remember users’ sorting habits and save their personalized settings for fax sorting.

• **Exit**: Exit FaxView without log out. Next time Faxview can be start without prompt for username and password. To fully logout faxview, click on the **down arrow** under **Exit** button and select **Logout**

![Logout](image)

**Notes:**
Users can also perform the above-mentioned operations by right mouse click.

### 2.2.1.2 Options Tab

**Options** tab lists all the options designed for system settings, including system information.

- **Phonebook**: Add, remove and edit contacts. Import and export Phonebooks.
- **User info Option**: Edit user information.
- **Send Profile**: Edit send options, including setting default cover sheet.
- **Change password**: Change FaxView’s login password.
- **Archive Fax**: View the archived faxes.
- **Associated group of users**: Manage group member of the Associated group which manage by login user.
- **New**: Create a new folder in left panel.
- **Edit**: Edit folder information.
- **Delete**: Delete folders in left Panel.

![Options Tab](image)

### 2.2.1.3 Style Tab

Users can change the interface style by clicking a below button in Style Tab in the menu bar.

![Style Tab](image)
2.2.2 Fax List

In fax list, users can view all the inbound and outbound faxes, as well as their properties, including document ID, status, subject, pages, date, and etc. Besides, user can sort faxes by any item of properties for quick search and easy reading.

2.2.3 Left Panel

Users can select the folders listed in the left panel.

Fax: Allow users to manage their own fax folders

Fax Manager

- **Need approval**: Only when the users have Group Administrative Operate Permission or Administrative Operate Permission, will the folder appear. The folder contains all the faxes need to be approved.
- **All Faxes**: This folder is only visible to the system administrator. The system administrator can view all the faxes of the users, except super user’s, by clicking **All Fax** at **Fax Manager** in the left. The system administrator can perform view, edit and delete operations on these faxes.
- **Group Fax**: This folder is only visible to the group administrator. The group administrator can view all the faxes of the group members, except super user’s, by clicking **Group Fax** at **Fax Manager** in the left. The group administrator can perform view, edit and delete operations on these faxes.

Options

- **Phonebook**: Phonebook Management
- **User info option**: Change User Information
- **Send Profile**: Change Send default Setting
- **Change Password**: Change OceanFax Login Password
- **Archive Fax**: View Archived Fax
- **Delegates**: Invoke the delegates interface

**Delegates**: View the fax folder of delegators
2.2.4 Status Bar

Status Bar is at the bottom of FaxView. It provides the current user’s basic information, including current user, the connected server, OceanFax Version and the fax’s total number in the selected folder.

2.2.5 Help

To launch Help, click top right icon 📚 or click F1.

2.3 Fax Transmission

Fax transmission is a key feature that FaxView provides. In FaxView, users can deliver electronic documents efficiently and apply rich functions in fax transmission by advanced settings to meet their diversified needs.

2.3.1 Quick Transmission

Fax transmission by OceanFax is quite fast and simple. Only if users have a recipient’s fax number and a document, can they send a fax.

1. Click New Fax in Fax Tab.
2. In the “Basic Information” Tag, Input a fax number in “Fax No.” field.
4. Click Send.
2.3.2 Complete Transmission and Send Email by FaxView.

OceanFax supports cover sheet and different types of attachments.

Uses can send a fax with more information included by applying complete transmission. Also user could also have a backup fax number for a fax, just in case if the primary fax number is not able to call to, OceanFax will use Backup Fax no. to send the fax.

If OceanFax was configured to send email with mail server, user also can insert the email address in Email Address field to send the fax image through email too.

After submit the new fax and new email, the FaxView will show as separate record as below:-
Fax would be show the icon as 📧

Email would be show the icon as 📧

Notes:
For Backup Fax No feature:-
1. Must input Fax No. and cannot only input backup fax no. for send fax
2. Backup Fax no will use for send fax after OceanFax use Fax no to send fax but failed completely (failed also after retry)

For Send email through FaxView feature:-
1. This feature only available when OceanFax was configured for send email, please check with your system administrator.
2. If OceanFax system already enabled DSN feature, after the email was success to receipt and OceanFax received the return DSN was success sent, then the email status will change to OK, otherwise show Fail;
3. If OceanFax system did not enable the DSN feature, all the email will only show “send success” is mean the email was send to relay mail server success only. But OceanFax will not know if relay mail server was send failed to receipt.

2.3.2.1 Cover Sheet
An outbound fax with subject and cover sheet can provides more information. Users can select a cover sheet in the drop-down list of covers under Subject and cover in Basic information tab.

A cover sheet can include the below information:

- **Recipient**: Recipient’s name, fax number and company name
- **Sender**: Sender’s name, phone number, fax number and company name
- **Subject**
- **Cover Content**
2.3.2.2 Fax Attachment

OceanFax supports different formats of attachments, including doc, excel, pdf, txt, jpg, tif and etc. Users can upload multiple attachments at one time, as well as manage them by clicking right buttons.

- **Move Up**: Move the selected attachment up.
- **Move Down**: Move the selected attachment down.
- **Delete**: Remove the selected attachment.
- **Preview**: View the selected attachment.
2.3.3 Mass Fax

Mass Fax refers to sending a fax to more than one recipient at one time. OceanFax FaxView provides two different ways to process mass fax.

Notes:
Users can change attachment sequence by using Move Up or Move Down option.
2.3.3.1 Phonebook

If users want to send mass fax and all the recipients’ fax numbers are in phonebook, users can select the recipients directly from phonebook.

Follow the below steps to select contracts from a phone book.

1. Click New Fax in menu bar and click Phonebook in “Basic Information” tag.
2. Select a phonebook in the drop-down list of phonebooks in From field.
   - My Phonebook: The phonebook created by users.
   - Shared Phonebook: Applied together with the drop-down list of users. Users can select the phonebooks shared by the defined users.
   - Company Phonebook: Contain all the contacts with the Checkboxes next to “Company Phonebook” selected while they are newly created.
   - Groups: Contacts can be classified to different groups by selecting the Checkbox next to “Group”.
3. Select the contacts in the “select recipient” list. Users can select multiple contacts by pressing the SHIFT key and then clicking adjacent contacts, or by pressing the CTRL key and then clicking contacts that are not next to each other.
4. Click Select to add the selected contacts the list of Selected recipients.
5. Previewing the recipient list under Selected recipients and click Ok to confirm.
6. Click Send.
Notes:

1. Click **Select All** to select all the contacts of a phonebook as recipients.
2. If users select the Checkbox next to “Send Email”, the message will be delivered to recipients by email and fax at the same time. If not, it will only be delivered by fax.

2.3.3.2 Add Fax Recipients Temporarily

If a recipient is not in phonebooks, follow the below steps to create a new contact to the recipient list.

1. Click **New Fax** in menu bar and click **Phonebook** in “Basic Information” tag.
2. Click **Add** next to the “Selected Recipient” list to create a new contact.
3. Input the new contact’s information.
4. Click **Ok** to add the recipient temporarily.

![Add recipients](image)

2.3.3.3 Select by Group

Users can also select recipients by groups.

Follow the below steps to select recipients by groups:

1. Click **New -> Fax information-> Phone book**.
2. Select the Checkbox next to “Group” to show all the phonebooks.
3. Select a group in the “select recipient” list and click **Select** and all the recipients in the group are then added to the “selected recipients” list.
4. Repeat step 3 to add another group.
2.3.4 Adds-in
2.3.4.1 Priority Setting

When a user needs to put the transmission of a fax in higher priority, he can suspend it first and then set its priority by using this option. There are four choices for priority setting, including Highest, High priority, Normal priority and Low priority.

Therefore, users can re-arrange the fax transmission sequence to let some faxes being transmitted first and delay the others.

![Select priority]

Notes:
It is recommended to select High priority option to send an important fax in an emergency and select Low priority option for mass fax or large size files transfer.

2.3.4.2 Fax Resolution Setting

Users can control the quality of fax image by using this option. The default setting is Fine (200DPI). When users send faxes in large quantity, they can set fax resolution to Standard (100DPI) to accelerate the delivery speed. However, the image quality will be reduced.

![Select Resolution]
2.3.4.3 Delay Send Setting

Uses can set the delivery time by using this option instead of sending faxes immediately after being prepared.

It can meet the requirements of some recipients who only want to receive faxes in specific time or live in a different time zone.
Notes:
When the delivery time set for Delay send is earlier than or at the same time with the current system time, the fax will be delivered immediately.

2.3.4.4 Auto Resend Setting
If a fax fails to be sent due to busy line or line error, OceanFax will automatically resend the fax. Users can set the properties of auto resend by using this option.

- **Retry**: Set how many times in total to resend.
- **Interval**: Set the interval every time the fax is resent

2.3.4.5 Custom CSID
Users can set the sender’s fax number that displays on the fax (CSID) by using this option.
Fax Settings
- Priority: Normal-priority
- Fax Resolution: Fine (200DPI)
- Cheap Time: 00:00:00
- Delay Send: 19/6/2013
- Retry: 3
- Interval: 3

Sender Information
- Name: Administrator
- Fax No.: 29663300
- Tel:
2.4 Fax Reception

Users are allowed to view and manage inbound faxes in the FaxView interface. When faxes come in, they will be automatically distributed to different users according to the system settings. When users access FaxView, they can view all their inbound faxes in Inbox folder (See below picture), including those sent from external fax numbers and sent, transferred, routed from internal users. All the inbound faxes can be replied to, forwarded and routed to the internal users and the external fax numbers.

2.5 Fax Operation
2.5.1 View

Users can view faxes with OceanFax’s original fax viewer - Tif Viewer under **MyFax**.

![Fax Viewer](image)

There are below four default folders:

- **My Fax**: contains all inbound and outbound faxes (Trash not included)
- **Inbox**: contains all inbound faxes
- **Outbox**: contains all outbound faxes
- **Trash**: contains all deleted faxes

There is two way to view the fax. One way is to double click the fax users want to view in fax list. The other way is to select the fax you want to view and then click **View** in Fax tab of menu bar.

Users can also create new folders to facilitate classifying and filing faxes.

2.5.2 Print

Users can perform this operation to print a fax while highlight a fax in fax list.

Follow the below steps to print a fax without open it:-

1. Highlight a fax in fax list.
2. Click **Print** Tool Bar.
3. Select a printer.
4. Click **Print**.
2.5.3 Sorting

Faxes can be sorted in the fax list based on the sender’s identification or other fields. FaxView will remember users’ sorting habits and save their personalized settings for fax sorting.

Select the field for sorting. The triangular icon will appear. The fax records show in ascending order with the apex upward or descending order with the apex downward.

The following graphic shows faxes sorted with ascending order by “Document No.”:

![Faxes Sorted Ascending by Document No.]

2.5.4 Print

Highlight any fax in fax list, click Print button to print. Support multiple faxes selection.
2.5.5 Refresh

FaxView automatically refreshes for every 5 minutes. Users are also allowed to click Refresh in Fax Tab to refresh the fax list manually.

User can also change the automatically refresh interval by click down arrow under Refresh Button.
2.5.6 Search

2.5.6.1 Quick Search

Users can perform this operation to search faxes quickly and accurately by entering a key word into any field in fax list.

There are two ways for quick search. The first method is by entering keyword in list boxes of fields, the second method is by selecting criteria in drop-down menu.

Entering keyword in list boxes of fields

Example: follow the below step to search all the faxes with the fax number starting with 23:

Enter 23 in the list box of “Fax No.” field and then all the faxes with the fax number starting with 23 are listed in fax list.

Select criteria in drop-down menu.
2.5.6.2 Advanced Search

For certain complex searches, users might want more control over the results that they see. They can perform Advanced Search operation to set up self-defined filters by single condition search or multi-condition search, making searches more precise and getting more useful.

**Single condition search**

**Example:** Follow the below steps to search all the faxes fails in delivery:

1. Put the mouse on “Status Information” field and then Icon appears at the right side. Click the Icon.

2. Click **Custom** in the drop-down menu.

3. In Custom AutoFilter dialogic box, select *does not equal* in the drop-down list and enter **OK** in the field and then Click **OK**.

4. The following graphic shows the search results:
Multi-condition search

Example:

Follow the below steps to search the faxes from page 3 to page 5:

1. Put the mouse on “Pages” field and then icon 🎨 appears at the right side. Click the icon.

2. Click **Custom** in the drop-down menu.

3. Set the filter as the above graphic and then click **OK**.

4. The following graphic shows the search results:
2.5.6.3 Fax Data Filter

OceanFax FaxView provided an easy to use but very powerful filtering function. It supported unlimited rules for a filtering. Even it is very powerful, but you do not need to learn any complex filtering statement, you can complete a complex filter with a simple few step.

For example, if you want to find out all fax with the following condition: Fax Number begins with 2345 and have only have 1 page; or the faxes Fax Number is 29876543 and the fax sent or receive before 1Oct2010.

1. Right Click any field name in the fax list and then click Filter editor.

2. Click the logical keyword And to select different logical keyword. In this example, we use the default value “And”.

3. Click the + next to the logical syntax “And”, to add a new condition.

4. Click the field in blue colour. We can change which field use for the condition. We use fax no.
5. Click the condition syntax in green colour, to select using what condition for filtering. We use “Begins with” in this example.

6. Click “Enter a value” to input the value.

7. We using “2345” in this example

8. The first condition has been finish. You can delete the condition with the “x” a the end of the condition.

9. Using the step 3-6 to add the other condition – only 1 page in the fax.

10. Start to add Or rule. Click Add Group to add a new group of rule.
11. Click the new “And” symbol, and change it to “or”.

12. Use the same method as step 3-6 to add the conditions under the second group.

13. After all condition added, click **Apply**.

14. Click **OK**. The fax list will only show the fax’s fax no. begin with 2345 and contain only 1 page. Or the fax’s fax no. is 29876543 and the fax sent or receive before 1 Oct, 2010.

**Notes:** Logical Keywords:

1. “And” – Filter records that fulfill all condition under the “And” tree.

   **Example:**
   
   ![And Example Diagram]
   
   Filter the records that the caller ID between 100 and 200

2. “Or” – Filter records that fulfill any one condition under the “or” tree.

   **Example:**
   
   ![Or Example Diagram]
Filter the records that Caller ID is “between 50 and 100” or “between 200 and 250”.

3. “Not And” – Show all records except the record fulfill all condition under the “Not And” tree.
   Example:
   ![Filter example](image)
   Filter the records except the caller ID between 100 and 200.

4. “Not Or” – Show all records except the record fulfill any one condition under the “Not Or” tree.
   Example:
   ![Filter example](image)
   Filter the records except the caller ID “between 10 and 50” or “between 100 and 150”

5. “Add Condition” – Add a new condition under the tree

6. “Add Group” – Add a new group. Can make some group of condition with different logical keyword (“And”, “or”, “Not And” and “Not Or”).

Condition Keywords

2.5.7 Move

Users can perform this operation to classify faxes into different folders by type, importance, project or other criteria.

Follow the below steps to move a fax to the destination folder:
1. Select a fax and click **Move** in the **Fax** Menu.

![Move button in Fax Menu](image)

2. Select the destination folder and click **OK**.

![Destination folder selection](image)

**Notes:** Drag-and-drop function: Click a fax and drop it to the destination folder.

---

2.5.8 **Delete**

Users can clean up outdated or junk faxes periodically to keep FaxView a clean interface. The deleted faxes will disappear from the fax list in FaxView and yet still be stored in **Trash** folder.

1. Select the fax you want to delete. You can select multiple faxes by pressing the SHIFT key and then clicking adjacent faxes, or by pressing the CTRL key and then clicking faxes that are not next to each other.

2. Click **Delete** in the **Fax** Menu.
3. Click **OK** to confirm.

*Notes:* Users can also directly click **Delete** on their keyboards to delete a selected fax. The faxes are under transmission cannot be deleted.

### 2.5.9 Edit

Users can modify some information of an inbound fax to update some of its properties, including Subject, Sender information etc. Follow the below steps to edit a fax:

1. Select a fax and click **Edit** in Fax Menu.

2. Update the properties and then click **OK** to confirm.

*Notes:* Only inbound faxes can be edited.

### 2.5.10 Combine

Users can perform this option to combine two or above selected whole faxes or part of faxes to a new fax for transmission or easy management and review. The fax created by combining the existing faxes is regarded as a new fax and can be routed and forwarded. Its subject will be “Combine from faxes: xxx, xxx” (xxx as the document ID of the faxes”). All the faxes to be combined must be inbound or outbound faxes at the same time.

1. Select the faxes you want to combine. You can select multiple faxes by pressing the SHIFT key and then clicking adjacent faxes, or by pressing the CTRL key and then clicking faxes that are not next to each other.

2. Click **Combine** in fax menu bar.

3. Adjust the sequence of the fax by using **↑** **↓** button.

4. Select the page of each fax (By default, All page selected)
5. Click 📅 to preview the fax and Click X to remove the fax is not needed.

6. Click OK to combine.

   Notes: The combined fax will be kept in “My Faxes” folder; the Status is “New Fax”. And the Subject should be “Combine from faxes: xxx, xxx” (xxx as the document ID of the faxes”)

2.5.11 Split

Users can perform this option to split a multiple-page fax into multiple individual faxes according to requirements. The fax created by split will be regard as a new fax.

Follow the below steps to split a fax:

1. Select the fax you want to split.

2. Click Split on Fax Menu.

3. Input the condition in the dialog box of split windows. You can use “;” to split few fax at same time.

   For example: 1-2;1,3,5;4-6

   Three new faxes will be created in this example. The first one contains page 1 to 2, the second one contains page 1, 3 and 5, and the third one contains page 4 to 6.

4. Click OK to split.

   Notes:

   If the Checkbox next to “Keep Original Fax” is selected, the fax’s original copy will be kept after splitting. Otherwise, the original copy will be deleted after splitting.

   The new fax created by splitting will be kept in “My Faxes” folder and in “New Fax” status. Its subject will be “Split from faxes: xxx” (xxx as the document ID of the original faxes”).

2.5.12 Reply

Users can perform this option to directly reply to an inbound fax, with no need to input recipients to avoid any mistake due to manual input. Follow the below steps to reply an inbound fax:
1. Select an inbound fax you want to reply.
2. Click **Reply** on the fax menu.
3. Input fax content and attach fax images.
4. Click **Send**.

### 2.5.13 Forward (to Internal Users)

Users can perform this option to forward a fax to other OceanFax Users with the original copy kept after forwarding. Follow the below steps to forward a fax:

1. Select a fax you want to forward.
2. Click **Forward** in **Fax** Menu.
3. Select users and click **Add** to add them to the selected user list.
4. Click **OK** to confirm.

![Select user window](image)

### 2.5.14 Route

Users can perform this option to pass a fax to other users with no copy left. Follow the below steps to rout a fax:

1. Select the fax you want to route.
2. Click **Route** in **Fax** Menu.
3. Select users and click **Add** to add to the selected user list.
4. Click **OK** to confirm.
2.5.15 Out (to External Fax Numbers)
Users can perform this option to forward a fax to external fax numbers. Follow the below steps to forward a fax to an external number:

1. Select the fax you want to forward out.
2. Click **Out** on **Fax** Menu.
3. Input the recipients, including recipient name, fax number and company name or select recipients from a phone book (Refer to 2.3.3.1 phonebook).
4. Click **Send**.

2.5.16 Resend
Users can perform this option to turn an outbound fax as a new fax's attachment and send it to the previous recipients again. They are allowed to resend multiple faxes at one time. This operation is suitable for a user to meet a recipient’s request to resend the same fax that the user has sent to him before, or resend the faxes which are failed to be sent to the recipients due to busy fax lines. Follow the below steps to resend a fax:

1. Select an outbound fax you want to resend.
2. Click **Resend** on **Fax** Menu.
3. Click **OK**.

2.5.17 History
Users are allowed to view the record of the execution of each step on each fax, including transmission, view, conversion, approval, and etc.
2.5.18 Right Mouse Click

Users can also perform the operations mentioned above by right click.

2.5.19 Heavy Fax Data Loading

OceanFax FaxView supports the below way to load heavy fax data.

When users log in FaxView each time, only the latest 1,000 faxes will be loaded to the fax list. If they want to view the earlier faxes, they need to pull the scrollbar to load another 1,000 faxes each time.

2.6 **TiffViewer**

Tiffviewer is a powerfully viewer to allow you to modify, annotate and manage your Fax document.

Below section will instruction common function and some special function in Tiffviewer which did not mentioned in other section within this document.
2.6.1 Save

Users can perform this operation to save a fax while opening it with Tif Viewer.

Follow the below steps to save a fax:

1. Click File → Save As in Tool Bar.
2. Input file path, file name (the default file format is Tif or Pdf)
3. Click Save.

2.6.2 Normal view and Page break view

For some incoming fax, when the every page size are normal size (e.g. A4, A3, Letter), we can use normal view to view it. However, when some incoming fax page are longer than a normal size (e.g. a page with doble highest of A4), then we can use Page break view to view it or to split the current fax page into two parts in left and right or top and bottom, so users can print different sections of the fax page. Follow the below steps to split a fax window:

1. Open a fax in Tif viewer.
2. Click File/Page break preview.
3. Drag-select on section and then Click Print by Fax Printer.
2.6.3 Print

Users can perform this operation to print a fax while opening it with image viewer.

Follow the below steps to print a fax through Tifviewer:-

5. Click **File → Print** Tool Bar.
6. Select a printer.
7. Click **Print**.

2.6.4 Print page break

Users can perform this operation to print a fax while the received fax have some page longer than a A4 size, to avoid the printout will be reside to a A4 page size.

Follow the below steps to print a fax with page break function:-

1. Click **File → Print Page Break** in Tool Bar.
2. Select a printer.
3. Click **Print**.
2.6.5 Paint on Fax

Allow us to modify the Fax image, by Pen tool, Line tool, Circle tool, Rectangle tool and Eraser.

1. Click on Paint icon button on the Tiffviewer’s tool bar
2. Modify your fax image
3. When finish, click Save button in Paint window
4. Remember click Save to Server icon in Tiffviewer to upload the fax image after modified.
2.6.6 Attachment Fax image to Email directly

To attachment opened Fax image to an Email directly, we can click on Email icon in Tiffviewer’s tool bar, select PDF format or Tif format.

Then the email client will popup with Fax image attachment.

2.6.7 Add text and text stamp

We can add any text word on a Fax, also we can save any text word as a stamp for us to re-use it.

1. Click on Text icon on the Tiffviewer’s tool bar.
2. In the input text dialog box, input any text you want to print on the Fax image
3. Click Add to Favorites if you want to reuse it later as a stamp.
4. Click OK want to finish the text input.
5. Place the text on anywhere you want on the fax image.

6. Remember click on Save to Server icon button on Tiffviewer’s tool bar to upload modified Fax image to save.

7. To reuse saved Text stamp, you can click on the down arrow beside the Text icon.
Notice: When Stamp onto all pages checkbox are ticked. Then the same draw, stamp, text, etc will also copy and paste to all the page at the same position.

2.6.8 Freehand draw tool

In Tiffviewer, there have an Free hand draw tool allow user to draw and paste on Fax image.
1. Click on Clock icon on the Tiffviewer’s tool bar.
2. Then paste the timestamp on the fax you want.
3. Click Save to server button to upload the modified Fax image to server.
4. Paste the draw on the place you want on the Fax image
5. Remember to click Save to server button to upload the modified fax image to server
**Notice:** When Stamp onto all pages checkbox are ticked. Then the same draw, stamp, text, etc will also copy and paste to all the page at the same position.

2.6.9 Time stamp tool

In Tiffviewer, there have an time stamp tool allow user to stamp timecrop on fax.
Click on Pen icon on the Tiffviewer’s tool bar.
Draw everything you want and click on the green Tick to finish.

**Notice:** When Stamp onto all pages checkbox are ticked. Then the same draw, stamp, text, etc will also copy and paste to all the page at the same position.

### 2.7 Folder Management

#### 2.7.1 Create Folder
Users are allowed to create and define new folders for classifying the different types of faxes.

Follow the below steps to create a new folder:

1. Select the “Options” tag in the menu bar.
2. Click **New** in the “Options” menu.
3. Input the folder name, and select the Parent Folder.
   
   **Note:**
   
   Parent folder mean the new folder is under which folder.
   
   For example, if users select “Inbox”, the new folder will under the Inbox.

   ![Folder creation example]

   ![Folder structure example]

4. Click **OK** to confirm.

### 2.7.2 Edit Folder

Follow the below steps to edit a folder:

1. Click the **Edit** in the **Options** Menu.
2. In the “Folder Info”, select the folder you want to modify and then input the folder name in the “folder name” field and select the new parent folder.

3. Click OK to confirm.

2.7.3 Delete Folder

Users can delete the useless folders in their OceanFax accounts. Before deleting a folder, users must move or delete all the faxes in the folder. Follow the below steps to delete a folder:

1. Select the folder you want to delete.
2. Select the “Options” tag in the menu bar.
3. Click Delete in Options menu.
4. Click OK to confirm.

Notes:
The default Inbox, Sent and Trash folders are created by FaxView system, which cannot be edited and deleted.
2.9 **Phonebook**

2.9.1 **View Phonebook**

Users can not only create contacts or contact groups in phonebooks for their own use, but also share them to other Users.

There are two ways to open the Phonebook interface:

Option 1: Click **Phonebook** button on Options Menu.

Option 2: Click **Phonebook** under “**Options**” on Left Panel.

2.9.2 **Phonebook Search**

Users can perform this operation to search contacts. The way is the same as “Advanced Search” of fax (Refer to **Chapter 2.5.6.2**). Users can also apply the search function when they create a new fax:
2.9.3 New Phonebook

2.9.4.1 New Group

Users can classify contacts to multi-layer groups in phonebooks. Follow the below steps to add a new group:

1. Click **New** and **New Group** in phonebook interface.

2. Input the group information including Group name, Parent and Remark.

3. Click **Save**.

Example:

![New Group Example]

2.9.4.2 New Contact

Follow the below steps to add a new contact:

1. Click **New** in a phonebook, and then input the new contact’s information.

2. If the Checkbox next to “Shared Phonebook” is selected, the new contact will be shared with all the users. (Refer to 2.3.3.1 Phonebook).

3. If the Checkbox next to “Company Phonebook” is selected, the new contact will be added to the company phonebook. The contact can be found in the company phonebook while creating a new fax. Only administrators or users have administrative permission can add contacts to company phonebook.
2.9.5 Edit Phonebook

2.9.5.1 Edit Group

Follow the below steps to edit a group:
1. Open a phonebook.
2. Select the group you want to edit.
3. Rename the group or/and change the parent.
4. Click Save.

2.9.5.2 Edit Contact

Follow the below steps to edit a contact:
1. Open a phonebook.
2. Select the contact you want to edit.
3. Revise the contact’s information.
4. Click Save.
2.9.6 Delete Phonebook Record

2.9.6.1 Delete Group
To delete a group, users must delete all the contacts in it first. Follow the below steps to delete a group:

1. Select an empty group you want to delete.
2. Click **Delete** in the phonebook toolbar.

![Phonebook Toolbar](image)

2.9.6.2 Delete Contact
Follow the below steps to delete a contact:

1. Select a contact you want to delete.
2. Click **Delete** in the phonebook toolbar.

2.9.7 Import Phonebook
Follow the below steps to import a phonebook:

1. Click **Import** in the phonebook toolbar.

![Phonebook Toolbar](image)

2. Click **View** in the Import interface, and find the txt or CSV file that contains the phonebook records. Users can select Replace, Rename or Do Not import the duplicate record and then select which group the record will save to.

3. Click the Check-box next to “shared phonebook” or “Company Phonebook” if needed and click **Next** to continue.
4. Select the field to be imported (Generally no changes needed) and click **Next** to continue.
5. Preview which records will be imported and then click **Finish** to start importing.

**Notes:** OceanFax determines the duplicate records by the full name of the records.

### 2.9.8 Export Phonebook
Follow the below steps to export a phonebook:

1. Click **Export** in the phonebook toolbar.

2. Click **View** in the export interface to select the location the file will be exported.
3. Click **Next** and select the fields to export.
4. Click **Finish** to start exporting.

### 2.9.9 Share Phonebook
Refer to **2.8.4.2 New Contact**.
2.9.10 Refresh Phonebook

After user import new phonebook, FaxView might not able to refresh asap. User could click on Refresh button to refresh the phonebook list to show all the latest update records.

2.10 User Profile

2.10.1 Send Profile

Customize the default setting of sending new fax. Refer 2.3.5 Advanced Feature for options’ meanings.

Follow the below steps to change the sending profile (Default setting of sending fax):

1. Click **Send Profile** in Options Menu.
2. Change the setting.
3. Click **Save**.
2.10.2 User Information

Some features require user information access for turning it to sender’s profile and fax header, so users must keep their user information complete and updated.

Follow the below steps to update user information:

1. Click User Information in the Options Menu.
2. Update the information.
3. Click Save.

Notes:

It is recommended to input the information in English to facilitate Header setting.

2.10.3 Change Login Password

Follow the below steps to change login password:

1. Click Change Password in Options Menu.
2. Input old and new password respectively.
3. Click OK to save the new password.
2.19 **Interface Style**

OceanFax supports twelve interface styles. Users can change their interface style by clicking the below icons.
2.20 Multi-language

Users can change their user interface language by following the below steps to set the user interface language:

1. Click **User Information** in the Options Menu.
2. Select your language in the drop-down list of languages, including English and other 8 languages.
3. Click **Save**.
4. Restart FaxView to start the new interface.
3. PRINT TO FAX

This function enables the way of fax transmission by converting a fax image into a tif file and then faxing it out as a fax attachment. For example, users can fax a document in word, excel, txt, pdf or jpg format out quickly by using this option after open it. Follow the below steps to print to fax:

1. Open a doc file, click **Files** and then click **Print**.

![Print dialog](image)

2. Select **OceanFax Fax Printer** in Printer options, adjust Printer property if needed.

3. Click **Print** and then the FaxView “Login” dialog appears.

4. Enter the login username and password.

5. Input the fax information including fax number in the “Fax Information” dialog box.

6. Click **Send**.

![Fax information dialog](image)

**Notes:**
Print to Fax supports automatic login, which means login once with no need to re-login again next time.
*** End of document ***